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Configurar la copiadora o escaner en formato TIFF.

Como recomendacion, que directamente desde la copiadora o escaner se
digitalice en formato TIFF, con las siguientes propiedades:

Formato TIFF

Blanco y negro

Resoluciéon 250 x 250 ppp
Compresion CCITT T.6 (Grupo 4)
Multi pagina

wnhwnNR

Ejemplo 1:

ﬁ
Lado: Ambos : @ ®) Q’ $ [ ' -3+ B~ @@
Generel | Tamato | Austes | Resicss| 109220 )JCAEER Gl b s msmndens

Escanear como:

i] | Blanco y negro (1 bit) v]
Tipo de documento:

Texto con gréficos v]
Tipo de soporte:

D | Papei romal z)
Resolucién:

B »

Compresion

Tipo:
e (oo ]

m »

< Inicio ] Dispositivo > T [ Vista previa | [ Aceptar [ Cancelar
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Canon DR-G1130 on STI - 0005

Preferencia del usuario - | B4sico | Brilo. | Pracesando imagen | Aimentacion | Otios | Impresion st « [+ |

Ejem plo 2: AEREGED] Modo de color - [Blancoynegfo v]
I Configuiaciones. .. |

Tamaflo pégina : {LEGAL ’]

[ Guardar... ] [ Area.. ]

Puntos por pulgada : {240 ppp ']

Lado de escaneado {Doble caa ']

Configuraciones...

Guardar(Y)... S0Rd 0o Imagen: Prioridad de velocidad S

| Enderezamiento automético | Configuraciones

Boarld)

[W [T Invertir lado a escanear
co ) | (o]

[ Aceptar | [ Cancels | [Predeteminado] [ ApudaiH) |

* Propiedades de 202300121468 tif x
Especiﬁcaciones General Seguridad Detalles  Versiones anteriores
necesarias del archivo. Propiedad Valor ~

Origen
Fecha de captura
MNombre del programa
Fecha de adquisicion
Copyright
Imagen
Id. de imagen
Dimensiones 2125 x 3500
Ancho 2125 pixeles
Alto 3500 pixeles
Resolucidn horizontal 250 ppp
Resolucion vertical 250 ppp
Profundidad en bits 1
Compresian CCITTTE
Unidad de resolucian 2
Representacion del colar
Rits comnrimidas /nixel N
Quitar propiedades e informacidn personal
I Aceptar I | Cancelar | Aplicar
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1. Instalacién y configuracion de la herramienta IrFanView:

1. Ingresamos a la siguiente liga: https://www.irfanview.com/

% IrfanView - Official Homepage - X =+ 1

€ &

@ IrfanView

VERSION 4.62

& https://www.irfanview.com

One of the Most
Popular Viewers
Worldwide

DOWNLOAD v

LANGUAGES PLUGINS SKINS SCREENSHOT

£ DSC_0931_Daisy.jpg - IfanView

ABOUT v  SUPPORT FAQ

IRFANVIEW GRAPHIC VIEWER

Fast and compact ( just 6 MB )

Freeware for non-commercial use

Supports Windows XP, Vista, 7, 8, 10 and 11
32 and 64 bit version

Multi language support

Unicode support

Designed to be simple but powerful

v v vy voww

More information about IrfanView

4 | would like to sincerely thank all you
& & faithful IrfanView users who send me
; messages of good wishes, congratulations
and appreciation. THANKS |

Irfan Skiljan. About the Author

GET IRFANVIEW (VERSION 4.62)

The program is available in 32 and 64 bit
Which version should | download?

See 64-bit info.

32-BIT 64-BIT

© DOWNLOAD

Current version 4.62

OTHER DOWNLOAD SITES

DONATE / SUPPORT / REGISTER JRFANVIEW

© DOWNLOAD
Current version 4.62

USEFUL PARTNER SITES

Stempelservice:
www stempelservice de

Lunacy, free design software
icons8.com/lunacy

Top 5 UI/UX design agencies
Clay UI/UX design

Branding services for startups
Ramotion

LOOKING FOR IRFANVIEW
AS WINDOWS 10 APP?
(MS APP STORE)

32-bit App

64-bit App

2. Descargamos la opcién para 64-BIT o de

operativo.

acordd a su sistema


https://www.irfanview.com/
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Automaticamente abre una nueva pestafia y descarga el archivo ejecutable
iview462_x64_setup.exe

v - (m] X
% IrfanView - Official Homepage - X Q) IrfanView download latest versic. X 4
c @ httpsy//www.fosshub.com/IrfanView.html?dwli=iview462_x64_setup.exe B e « 02 :
O FOSSHUB CATEGORIES ABOUTUS FAQ BLOG SIGNUP  CONTACT f\\
RPN
ANTI MALWARE
AUDIO EDITORS Fkdkok 5/ 2180 28,386,111 Dec g, 2022
Report misleading | Advertisement
AUDIO PLAYERS R
DX

BACKUPTOOLS
BROWSERS
BURNING TOOLS
CHAT CLIENTS
CODEC PACKS
DATABASE Reportmisleading | Advertisement
DEVELOPERTOOLS

IRFANVIEW DOWNLOAD
DISK ANALYSERS IrfanView 64-bit Windows Installer Signature 4 MB 462 0 /15

IrfanView All Plugins - 64-bit Windows Installer Signature 241 MB 462 0 /15
EBOOK APPS

IrfanView All Plugins - 64-bit Windows ZIP Signature 216 M8 462 o /15
EMAIL CLIENTS

IrfanView 32-bit Windows Installer Signature 31MB 462 0 /15

This website uses cookies that help us to deliver our services. By using our services you agree to our use of cookies. More info Gotit!

ﬁl viewd62_x64_setup.exe ~ Mostrar todo x
™~

A}

Ejecutamos dando clic, nos preguntara: ¢Quieres permitir que esta
aplicacion realice cambios en tu dispositivo?, le decimos que Si.
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Nos abre la siguiente venta y nos pide seleccionar en donde crear accesos
directos o atajos y dejamos seleccionada Unicamente la primera opcién.

iew 64 setup!

e IrfanView |

This program will install Irf;
(it should be started wi

iew version 4.62 (64 bit) on your system.
Admin pemissions)

Create

Create IfanView shortout on the Desktop
[ Create IfanView Thumbnails shorteut on the Desktop Uncheck all
[ ] Create Ifan\iew shortcut in Start Menu Programs

(®) For cument user only
() For all users

Installation folder:

|C:‘xF‘n::gram Files*Ifaniew" Browse

Fead Ifan‘iew EUULA (End User License Agreement).

< Atras Siguiente = Exit

Dejamos la carpeta que por default nos sugiere para el guardado de la
herramienta.
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Nos abre la siguiente ventana, donde menciona algunas caracteristicas de

la version.

i IrfanView 64-bit Setup *

‘What's new in this version?

Version 4.62 (Release date: 2022-12-09)

- Mew PDF Plugln {hanks to Pdfium guys)

- Option to save slideshow as MP4 video (Thanks to Shao Woon Wang)

- Mew options menu: Append cument image to PDF ({Options->Multipage images)
- Mew options menu: Edit muttipage PDF (Options->Multipage images)

- Mew "Adobe BBF fiters" Plugln (also for 64-bit 8BF, thanks to Sinisa Petric)

- Mew in Advanced Batch dialog: All effects (Effects Browser dialog) can be used
- Mew in Properties-=BExtensions dialog: Load only minimal (browsing) extensions

- The selection rectangle can be resized on comers (with CTRL = proportional) Damos clic en
- Change for "Paste into Selection”: you can move/resize the selection
rectanale/image; Click to apply selection image to main image Siguiente

- Mew option in "Compare images” dialog: Show diference image

- Mew effect in Image->Effects menu: Skew/Shear image

- Mew hotkey: CTRL + SHIFT + G: Start Google Maps with GPS of the loaded file

- New command line option: fs_exit
== if started in fullscreen mode; ESC closes fullscreen and IfanView

- Old/obsolete JPG options disabled: "Load as grayscale” and "Save as grayscale”
(easy to forget; can be re-enabled using new INI flags)

- Removed very old Plugln: Fitters inlimited

- Several Pluglns are changed/updated, please install the newest versions: e
Download from: hitps://www ifanview .com/plugins htm

y/

=

i3 IfanView 64-bit Setup X
Do you want to associate extensions with kfanView? (OPTIONAL !)
INFO: on Win10, you need also changes in: System Settings. Apps. Set defautt apps !
~
O ani Animated Windows Cursors * En la siguiente
[]83D BodyPaint 3D Format *
D BMP,/DIB Windows Bémap ventana nos pregu nta
Ocwe Windows Clipboard que tipo de archivos
[CJ CRW/CR2 Canon RAW Format * .
CJcur Windows Cursor queremos relacionar
] DCM/ACR/IMA DICOM Fomat * con el |rFanVieW' le
[J bcx Multipage Zsoft Paintbrush .
(] oos Direct Draw Sufface * decimos que
[ buvunwas DiVu Format * Ninguno
] oxrF Drawing Interchange Format * ,'
O ecw Enhanced Compressed Wavelet * y después
Loe e ] Siguiente
INFO: ¥ you are just updating an older version, you can leave all boxes unchecked /
* - Plugins Images only
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5 IfanView 64-bit Setup X

Ready to install!

Destination directory: C:\Program Files\IfanView .
En la siguiente venta

seleccionamos la opcidn
de *Carpeta de datos de
la aplicacién del usuario
recomendada y después

Siguiente

Set INI file folder (advanced):
O IfanView folder
(® User's Application Data folder (recommended for Vista, Win 7. Win 8, Win 10)

Installing ... please wait ...

Press the "Next" button to start the instaliation ...

L

< Mms SigurarS > Exit

i3 IrfanView 64-bit Setup *

Installation successful!

Setup has finished installing this program on your computer,

En la siguiente venta
seleccionamos la opcidn
~ de *Comenzar IrfanView

y después
What to do next? Echo.
[JOpen IfanView FAGS hom
[ Start IrfanView

How to uninstall IfanView?
Goto "Start->Programs->kfan\iew" and click the "Uninstall kfanView" dem.
{or, see in System Control Paned, Apps)

4

« Atras Siguiente > m
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‘ #E IfanView - O [}
File Edit Image Options View Help

| =] 3 N o > o -3
| ; T~ B = : = N (P
= m il &9 & 93 & ) e > 83 N EA 7

Se abre la herramienta
IrfanView
la cerramos para
proceder a instalar los
plugins.

|No file loaded (use File->Open menu)

-— Y S g —

Official Homepage swiload IrfanView latest refe +
e e R R e "\Continuamos en la pestana

de Download.

DISK ANALYSERS 64-bit Windows Installer
EBOOK APPS fanView 32-bit Windows Installer / DamOS C||C en
S fanView All Plugins - 64-k 'tj\)(/n‘\do\-./slnstaller All Plugins — 64-bit Windows

fanView All Plugins - 64-bit Windows ZIP |nSta||er

fanView All Plugins - 32-bit Windows Installer

fanView All Plugins - 32-bit Windows ZIP

Automdticamente descarga el

archivo ejecutable.
iview462_plugins_x64_setup

Ejecutamos dando clic, nos preguntara: ¢Quieres permitir que esta
aplicacion realice cambios en tu dispositivo?, le decimos que Si.

10
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35 IrfanView Plugins 64-bit Setup X

I h’f!!f'ml! Welcome to IrfanView Plugins setup!

This program will install addtional ifanView Pluglns version 4.54 (64 bit) on your system,
it should be started with Admin permissions)

The destination folder must be your base) IfanView 64-bit folder. Dejamos la carpeta que

i the installer cant find IfanView-&4 in the system reqgistry. please use the Browse' b
and find it manualy.

(Do MOT install these Plugins to IfanView 32-bit folder)

~ por default nos sugiere
para el guardado.

Destination folder:

|C:XngranHIes\Irfan'hﬁew\ < | Browse | Terminamos dando

Siguiente.

Pressthe “Siguente >"  button to start the installation ...

« Atras Siguiente > Exit

it
y IrfanView Pluglns 64-bit Setup x

Termina la instalacién y damos.

o Installation successfulll | Aceptar

Aceptar

il |

11
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¥ IrfanView - Official Homepage -

C @ https;//www.fosshub.com/IrfanView.htmi?dwl 462_x64_setup. © % ®» 0O =
@) PENSIONES gg IPAGOS & Sistemas g IntranetSistemas ) WhatsApp @ Nueva pestafia RADIO » Otros marcadores

Donate to remove ads Report misleading =~ Advertisement
AUDIO PLAYERS
BACKUP TOOLS
BROWSERS
BURNING TOOLS
CHAT CLIENTS

S Grammarly

CODEC PACKS e

Donate to remove ads Report misleading =~ Advertisement
DATABASE
DEVELOPER TOOLS IRFANVIEW DOWNLOAD

IrffanView 64-bit Windows Installer

DISKANALYSERS N v N

0 /15 462 4 mB Signature
EBOOKAPPS

IrfanView All Plugins - 64-bit Windows Installer

EMAIL CLIENTS 0 /15 462 241 m8 Signature
S IrfanView All Plugins - 64-bit Windows ZIP

apelerade >f-lctepad+¢
reciclaje

D &

Google Joad for
Oraclell 1.6

v = a X

N

X Q IrfanView download latest versic. X+

aA+

.
Bitstream§
!

VIt oW NG P Corel
PHOIO:

A continuacion, cerramos
el navegador de Internet.

Tenemos el acceso
directo en el escritorio y
damos doble clic para
entrar.

12
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*

File Edit Image Options View Help

EEHeX {E0 R eEs @ X R

Maximizamos la ventana.

Damos clic en herramientas

Mo file loaded (use File-> Open menu)

Properties/Settings X
Start / Exit options Pluglne
Nos abre la JFG /PCD / GIF . _
. Extensions Options for ARW, CRZ/CR3, DNG. NEF/NRW, RAF, ORF, MRW, ERF, MOS, RWL:
SIgu iente venta y ‘Eﬁrenﬁi;ﬁg Try to load embedded preview image (if available, otherwise halfsize)
damos clic en Editing Try to loac R2 using Canon DLLs {check "i_plugins t&t" for download, 32 bit o
Full screen / Slideshow
Pl Ugl ns Zoom options Load half-size RAW image (faster than full-size; uses CamBAW-Flugin)
Eq?::gron;ag;f:?em [ Use automatic white balance
File: Handling Use camera white balance, if possible
Language
\ Toolbar [ Don't automatically brighten the image
By Plugins

Miscellaneous

Cancel

Brightness: (defaut: 1.00)
Highlight mode: D (D- 9, defaul: 0)
TTF format:

Defautt text for TTF files: Load default text
| I"HEHA " +.-. /0123456789 .<=>P@ESABCOEFGHIKLMNOPQRS TUMWIYZ ™" §ab|

Custom path for Adobe 8BF Pluglns (Image menu):

| | Browse

En seguida damos clicen

Other Plugins:
Postscript options DXF/DWGE options el bOtO n de P D F
MrSID options PDF aptions <
JPM options SWiG options

13
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PDF Plugln Options et
Loading options:
Lise {new) "PDF.DLL" PlugIn for PDF loading
7 Otherwise the Ghostscript (must be installed) PlugIn will be used.
Nos abre la / (see the 'Postscript’ button in ‘Properties-=Pluglns' for G5 options)

siguiente venta,
activamos la

casilla. |

Saving options:
Use (new) "PDF.DLL" PlugIn for PDF saving

[otherwise the (old) ImPDF Flugln will be used)
Damosok |

DIRECCION GENERAL DEL REGISTRO PUBLICO DE LA
PROPIEDAD Y DEL NOTARIADO.

En esta opcidn se define la
resolucién de todos los
archivos PDf, esta
configuracion se realiza como
Unica vez.

Considerando que la

——resolucion tiene que estar en

el rango de 200 a 300 DPI,
sugerencia 250 DPI.

- Cancel
Properties/Settings X
Start / Exit options | Pluglins
e/ PeD /Gl Options for ARW, CR2/CR3, DNG, NEF/NRW, RAF, ORF, MRW, ERF, MOS, RW/L:
Eﬁ;\;:i;ﬁg Try to load embedded preview image (if available, otherwise half-size)
Editing Try to load CRW.CRZ2 using Canon DLLs (check "i_plugins txt" for download, 32 bit o
Full screen / Slideshow ) . )
Zoom options Load half-size RAW image faster than full-size; uses CamRAW-FPlugin)
Eﬁ:ﬂ:gqﬂg:ﬁ:drnem [] Use automatic white balance
File Handling Use camera white balance, if possible
Language
Toolbar [] Dont automatically brighten the image
Pluglns
Miscellaneous Brightness: (default: 1.00)

Highlight mode: D {0- 9, defautt: 0)

TTFfomt
Default text for TTF files: Load default text
Cancel |"HS L&)+ -./0123456789:;<=>?@SABCDEFGHIKLMNOPQRS TUVWXYZ]\ " _'§ab)|

En seguida damos clic en
Custom path for Adobe 8BF Flugins (Image menu):

el botdn.

Other Pluglns:

DXF/DWG options
MrSID options PDF options
JPM options SV3 options

14
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Ghostscript Plugln Option
Ghostscript (64 bit) location:

(®) Retrieve G5 location from System Registry {recommended), result:
[Ghostscript not found 1]

() Custom path ffor experts

DIRECCION GENERAL DEL REGISTRO PUBLICO DE LA

PROPIEDAD Y DEL NOTARIADO.

5 > -
Nos abre la siguiente venta y

seleccionamos el tamafo de papel
*Legal

. wite full DLL path/name):

|C:\Program Files\GS\B

in'\gsd32.di xd

Set image loading options:
Set papersize: | Legal

En la siguiente opcidn definimos la

*Resolucién (Puntos por Pulgada)

Set DPI: |25.|]. |: |25,|].| |

250 x 250

Enable Interpolation (better image quality)
Enable Artialiasing (better text quality)

Terminamos con OK

[] Enable Multthreading (can be faster) |

Cancs

Properties/Settings

Start / Exit options
JPG /PCD / GIF
Extensions
Viewing

Browsing

Editing

Full screen / Slideshow
Zoom options
Color management
Video / Sound

File Handling
Language
Toalbar

Miscellaneous

Cancel

| Pluglns
Options for ARW, CR2/CR3, DNG, NEF/NRW, RAF, ORF, MRW, ERF, MOS, RWL:
Try to load embedded preview image (f available, otherwise half-size)

Try to load CRW/CRZ2 using Canon DLLs {check "i_plugins " for download, 32 bit o Por u Itlmor
Load half-size RAW image faster than full-size; uses CamBAW-Plugin) cerramos |a
[ Use automatic white balance

ventana.
Use camera white balance, if possible

[] Dont automatically brighten the image

Brightness: (default: 1.00)

Highlight mode: D (0 -9, default: D)

TTF format:
Default text for TTF files: Load default text

[1"#1874°)°+./0123456789:;=> ?@SABCDEFG HIJKLMNOPQRSTUVWXYZ[\]"_'Sab|

Custom path for Adobe 8BF Pluglns (Image menu):

| | Browse

Cther Pluglns:
Postscript options DXF/DWG options
MrSID options PDF options
JPM options SVG options

15
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Damos clicen la
carpeta, para
abrir el archivo a
convertir.

#*

File Edit Image Options View Help
Y - e -
FEREaX 4L HE

Mo file leaded (use File-> Open menu)

Buscar en: | Agregados

v| g? ¢ v

-

f\% Mombre

lﬁl:,ﬂ\gregaclo a convertir
Acceso rapido

|

Escritoric

Bibliotecas
Este equipo

&

Red

Fecha de modificacion  Tipe

08/04/2020 11:33 3. m,

Decumento Adeb..

Tamafio

28,680 KB

MNombre de archiva:

Tipo de archivo:

Recent folders:

Allfiles (7.7}

—

Imagenes - <C:\Users\lgandarila‘Pictures'>

Preview active

=) 4= IEI hi\ %@ X ‘

Se abre la siguiente
ventana y buscamos la
ruta donde tenemos
guardados nuestros PDF’s

Inicialmente no mostrara
ningun archivo, por lo que
es importante que
seleccionemos en Tipo de
archivo: *Todos los

archivos.
Abrir
L Podemos dar doble clic
sobre el archivo o dar un
clicy enseguida
@ Abrir.

Nota: Es importante que el archivo origen se encuentre en formato vertical.

16
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Para convertir un archivo PDF

Para empezar a convertir
el documento damos en
guardar como

Nos abre la siguiente
ventana y busca la ruta
donde se guardara el
archivo.

En Tipo de archivo
seleccionamos TIF.

DIRECCION GENERAL DEL REGISTRO PUBLICO DE LA
PROPIEDAD Y DEL NOTARIADO.

3500x 24BPP /1 20%

Open..
Reopen

Open Recent files

Open with external editor

Open as

Thumbnails

Slideshow...

Start slideshow with current file list

Batch Conversion/Rename...
Search files...

Rename File..
Move File...
Copy File...
Delete File

Save (original folder)
Save as...

Compare images.
Save Selection as..
Print..

Select Scan/TWAIN Source...
Acquire/Batch scanning...
Copy Shop..

Exit

#E Open

M Agregado o convertinpdf - IfanView (Zoom: 557 x 918)
File Edit Image Options View Help

° b2 @ Q ¢ = XN

Shift-R
b
' \
y ln Al dlod Foaroman /.,/,9”.;4».,& ek dlo Giadudtine |
. NOTARIA PUBLICA No. 26 ]
0. MORELOS + ‘
_ . CHIHUAHUA. CHIH.
- PROTOCOLO ABIERTO ORDINARIC |
CtrleW pta afos, contadas @ partir ¢ |a firma de la presents escritura, E1 INSTITUTO |
7 L FONDO NACIONAL DE LA VIVIENDA PARA LOS TRABAJADORES [
celard el contrato de crédito y la hipoteca Que lo gerantiza, en & caso de yue
CtivE RABAJADOR pague y cumpla con Ia totalidad d lag obligaciones a su zargo.
CIMA SEGUNDA.- En los términos dei articulo 42 Cuprenta y dos de la Ley de |
=] ftita def Fondo Nacional de Ia Vivienda para los Trabajsdores, os actos !
7 picos contenidos en este documents en los que perticipa & TRABAJADOR

N exentos del pago de impussios y derechos Federales, Estatsies o del
F8  lrito Federal que pudiera causar

Del —CLAUSULA COMUN A LOS DOS CON

[CA.- Para 12 Interpretecién y cumplimisnto de este contrato lar pares se

Ctrl+S  Jeten ales leyes y kibunales del Distits Federal y o 1 Gudad de Chibuanua
feccion del INSTITUTO DEL FONDO NACIONAL DE LA VIVIENDA PARA

5
TRABAJADORES, INFONAVIT, con renuncia expresa de cusiquier oira
P aue pudiere cormesponderies por razon de su domicilia o do fa ubicacian &
Cirl+Shift+B  bedie objeto de este conrats,——

~——PERSONALIDAD
Crl+P | safior Licenciado GILBERTO BAE;

TENO NAVA y ef soflor Ingenisro WECTOR RICALDAY QUIROGA
Miestan bajo profesta de deci verad que &l cardcter con ¢l qua comparecen

Ctrl+Shift+A  Bs ha sido revasado, limitao, ni ha concluldn por causa alguna y que sus
Bsentados contindan en el goce de la copackied juldica que fanian al
s Su. feprasentacion ¥ & fin da acredlisr su persenalicad v iz legal

Esc  [Encia de sus representados me exhiben los sigulentes documsentos

Por Io que respecta al sefior Licenciado GILBERTQ BAEZA MELENDI
Primer Testimanko dé la Escritura Pblica Nimero §9,837 noventa y nueve mil
seiscientas b

“a y siete, olorgada en a Ciudad de México, el dis veinticuatro de
Marza de mil novecienios noverta ¥ nusve, anta i fe del Licanciado Eduardo
Garcia villegas, Notario Piblico Nomero Quince en ejarciclo para el Dist
Federal y en i3 cual consta e PODER GEMERAL PARA PLEITOS Y

Buscaren | Agregados vl (€] 5 il
E} MNombre . Fecha de modificacién  Tipo Tamafio
IEAgregado a convertir 24/06/2022 09:35 a. m. Documento Adob.. 2,820 KB

Acceso rapido

Escritorio

"
Bibliotecas

>

Este equipo

Nombre de archiva

Abrir

Tipo de archivo:

Allfiles (%)

i |

Cancelar

Recent folders:

PBM/PGM/PPM - Portable Btmaps
PCD - Kodak Photo CD

PCX/DCX - Zsoft Paintbrush

PDN - Paint NET Format

PNG - Portable Network Graphics
PSD/PSB - Photoshop Files

PSP - Paint Shop Pro Files

Q0! - Quite OK Image Files

RAS - Sun Raster Files

RAW/YUV - RAW Files

RLE - Utah RLE Files

SFF - Structured Fax Format

SFW - Seattle Film Works Files

5GI - Silicon Graphics Files

51D - LizardTech MrSID Format
SWF/FLV Flash/Shockwave Format

TTF - True Type Font Files
WAV/OGGE/MAASAAC/MID/RMLAWMASAIF/SND/AU/RASCDA - Sound Files
WBMP - WAP Bitmap

'WBZ/WBC - Webshots Format

WEBP - Weppy Fo

WMF/EMF - NIHdDWE Metafiles

'W5Q - Wavelet Scaler Quantization

XBM/¥PM - X-Bitmap
XCF - GIMP File Format
All supported Graphic Files
All supported Sound Files

2.85MB/

All supported Video Files
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CHIHUAHUA

GOBIERNO DEL ESTADO

Juntos Sipodemos

DIRECCION GENERAL DEL REGISTRO PUBLICO DE LA

PROPIEDAD Y DEL NOTARIADO.

M€ SavePicture s *
Guardar en: | Agregados v| (<] ¥ = G-
Mingun elemento coincide con el criterio de bisqueda, . .
* Al seleccionar el Tipo de
Acceso rapido .
archivo TIF nos abre la
-_ TIFF save options _— ventana donde definimos la
Escritorio ) //
_ Save Compression: COmpreSIén
m () None For Black/White images only:
Bibliotecas QLw (O Huffman RLE
Packbit CCITT Fax 3 = HF4
W OPacdita  OCCITT Fax Sefialamos la opcidn
Eete eoi (O JPEG (®CCITT Fax 4 s
€ equipo
_ o CCITT Fax 4
@ [] Save all pages from original image
Red [] Save palette for grayscale images (default: ON)
Mombre de archivo: | Agregado a convertir ~ Guardar Y por UItImo damos
Tipo: TIF - Tagged Image File Format Ld Cancelar Guardar
Recent folders Imagenes - <C:\Users\lgandarilla“Pictures'. s
[[] Save file with original date./time Show format options dialog
| T | Administrar Agregados
Inicio Compartir Vista Herramientas de imagen
I:I [ Iconos muy grandes [&] Iconos grandes il [[] casillas de elemento
lconos medianos lconos pequefios - |:| Extensiones de nombre ¢
Panelde [TH . Ec — Vista
navegacién = BE Lista f:= Detalles *  actual+ L] Elementos ocultos
Paneles Disefio Mostrar
<« v » Esteequipo » Documentos » Agregados

» 3k Acceso ripido

> &+ Dropbox

> @ OneDrive
> E Este equipo

v ' Biblictecas
> Documentaos
» =] Imdgenes
> £ Musica
> B Videos

> ¥ Red

.
Mombre

'E Agregado a convertir 1
@ Agregado a convertir 1
'@ Agregado a convertir 2
12 Agregado a convertir 3
ﬁ] Agregado a convertir 4
'@ Agregado a convertir 5

Tipo Tamafio
Documento Adob... 2920 KB
Archive TIF 1,161 KB}
Documento Adob... 2920 KB
Documento Adob... 2,920 KB
Documento Adob... 2920 KB
Documento Adob... 2920KB

Sele

En la carpeta designada
para guardar los archivos
convertidos, podemos
observar la diferencia entre
y
nueva versién en formato
TIF.

el archivo original la
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CHIHUAHUA

GOBIERNO DEL ESTADO
Juntos

podemos

DIRECCION GENERAL DEL REGISTRO PUBLICO DE LA

PROPIEDAD Y DEL NOTARIADO.

Para convertir mas de un archivo PDF

1. Seleccionamos la
opcion de conversion
en Lote.

2. Seleccionamos el
tipo de formato. ~7

3. Seleccionamos la
ruta donde se
guardara el archivo a

convertir. \

6. Por ultimo paso

¥ Agregado a convertirpdf - IfanView (Zoom: 557 918)

File | Edit Image Options View Help
Open.. 0
Reopen Shift+R

Open Recent files

Open with extemal editor

P RQeEs DD XY

|__

L]
it

. %, % .
S whlia: ol Cosammon Yabongeater Frocach o Vrdistliraw
NOTARIA PUBLICA No 26
DTO. LORELOS
_ . CHIHUAHUA, CHIH
PROTOCOLO ABIERTO ORDINARIC
tréinta aos, contados a partr de Ia fima de la presenta escritura. | INSTITUTO
DEL FONDO NAGIONAL DE LA VIVIENDA PARA LGS TRABAJADORES
canceiard el conrato de crédio ¥ la hipoteca que lo garantza, en ef caso de cue
¢l TRABAJADOR pague y cumpla con la otaicag o las obligaciones a su cargo.
DECIMA SEGUNDA.- En los témincs de articula 42 cusrenta § dos de Ia Ley de
Institsto de! Fondo Nacional o¢ Ia Vivienda para los Trabajacores, Ios actos
juridicos cantenidos en este documents en los que particoa

TRABAJADOR
estan exentcs del paga de impuesios y derechos Federales, Estatsies o dal
Distrito Fedaral que pudiera CouSas. —rrmmmmmmrrr oo
—CLAUSULA COMUN A LOS DOS CONTRATOS, —
UNICA.- Para 2 interpretacitn  cumplimiento de este cantroto lae partes. s
‘somelen a les leyes y tribunales del Distrito Federal y o i@ Ciudad de Chihuahya
a eloceitn del INSTITUTO DEL FONDO NACIONAL DE LA VIVIENDA PARA
LOS TRABAJADORES, INFONAVIT. con renuncia exprésa de cuslquis
Tuero que pudiere cormespanderies por razén da su domicilia o do fa ubic

PERSONALIDAD -
— Elsaflor Licenciado GILBERTO BAEZA MELENDEZ, Is serora ROSA MARIA
CENTENO NAVA y el seflor Ingeniero HEGTOR RIGALDAY QUIROGA
manifiesian bajo prolesia de deci vertad que el cardcter con e ques comparecen
7o les ha sido revacado, limitado, ni he concluido por causa iguns y Gue sus
fepresentados. contindan en &l goce de fa copacidad juridca que fenian ol
clorgaries su representacion y & fin de acredter su personalidad y a egal
fenci me exhiven los siguientes d

A):- Por ko que respecta al sefior Lissnciado GILBERTO BA
Primer Tesimonio do la Escritura Pblica Nomero 99,837 noven
Seiscientos rsinia y siete, otorgada

la Gaudad de Moo, el die veinticustro de
Marzo de mil novecienios novents y nueve, ante fa fe del Licanciado Equarde
Gercla Villegas, Notaria Publico Nimero Quince en ejercicis para e Distrity
Federal y en la cusl consta el PODER GENERAL PARA PLEITOS Y
COBRANZAS, ACTOS DE ADMINISTRACION ¥ DE DOMINIO que otorgera ol
sefor Licenciada LUIS DE PABLO SERNA. an su eavactar da Nirartor fio

Openas
Thumbnails T
Slideshow... w
Start slideshow with current file list Ctrl+W
Batch Conversion/Rename... B
Search files... Ctrl+F
Rename File.. F2
MoveFile... F7
Copy File 8
Delete File Del
Save (original falder) Ctrl+5
Save as... 5
Compare images...
Save Selection as... Ctrl+Shift+B
Print... Ctrl+P
Select Scan/TWAIN Source...
Acquire/Batch scanning... Ctrl+Shift+ A
Copy Shop...
Exit Esc

* Batch conversion

Work as

(®) Batch conversion

() Batch rename

() Batch conversion - Rename result files

Batch conwversion settings:

Output format:

TIF - Tagged Image File Format ~ Options
Advanced

[[] Use advanced options ffor bulk resize..)

Batch rename settings
Name pattem

image#it

Output folder for result files: (or placeholders, like: 3D}

|c:\Users'gandarila\Documents\Agregados

Usge cumrent (Look in’) folder Browse

[Jinclude subfolders for "Add all” button: not remembered)
[] Show Preview image

damos Empezar. —
Start Batch

Run test rename No preview possible !

Cancel

Buscaren: |

<

*

Acceso rapido

Escritorio

Bibliotecas

»

Este equipo

Sort files

Input files:{ 5}

Agregados - @& e mEr

KN, EIN. KN -
Agregado a Agregado a Agregado a Agregado a
convertir 1 convertir 2 convertir 3 convertir 4

[ PDF [

Agregado a Agregado a
convertir 3 convertir

Nombre de archivo: ‘ ~

Tipo de archivo: Allfiles (.7} &=

emove Move up

Remove all Move down

Add all

Load TXT

Save as TXT

C:\Users\lgandarils
C:\Users\lgandarils
C:\Users\lgandarils
C:\Users\lgandarils
C:\Users\lgandarils

“Documents\Agregados \Agregado a convertir 5.pdf
Documents\Agregados \Agregado a convertir 1.pdf
Documents\Agregados \Agregado a convertir 2 pdf
“Documents\Agregados‘Agregado a convertir 3.pdf
"Documents\Agregados‘Agregado a convertir 4 pdf

4. Buscamos la ruta
donde estan guardados
los archivos PDF a
convertiry en Tipo de
archivo seleccionamos,
Todos.

5. Seleccionamos

dando con la tecla
Ctrl + clic
sobre cada uno de los
archivos a convertiry
en seguida damos
Agregar.
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CHIHUAHUA

GOBIERNO DEL ESTADO

Juntos Sipodemos

Agui se muestra cémo se
va procesando archivo
por archivo y la ruta
donde se guardo.

Al final muestra el total de
archivos procesados vy si
hubo error en alguno.

Abrimos la carpetay
podemos ver los
archivos ya
convertidos.

DIRECCION GENERAL DEL REGISTRO PUBLICO DE LA

PROPIEDAD Y DEL NOTARIADO.

Batch conversion done

Processing file: C:\Users\lgandarillatDocuments \Agregados \Agregado a convertir 5.pdf
... Ok - C:\Users\gandarila\Documents \Agregados  Agregado a convertir 5iif

Processing file: C:\UsersYgandarilla‘Documents'Agregados* Agregado a convertir 1.pdf
Waming: Destination file already exists, NO overwnite: C:\Users'Igandarilla®Documents' Agregados\Agregado a convertir 14f

Processing file: C:\UsersYgandarilla® Documents'Agregadoz*Agregado a convertir 2 pdf
.. Ok - C:\Users‘lgandarila\Documents'\Agregados  Agregado a convertir 2 tif

Processing file: C:\Users\lgandarillatDocuments'\Agregados'\ Agregado a convertir 3 pdf
... Ok - C:A\Uzers\gandarilla\Documents \Agregados \ Agregado a convertir 34

Processing file: C:\UsersYgandarilla‘ Documents'Agregados* Agregado a convertir 4 pdf
.. Ok - C:\Users\lgandarila\Documents \Agregados Agregado a convertir 4.4

5 Files - Emors: ), Wamings: 1

< >
Copy to clipboard Stop Pause/Resume Retum to batch Exit batch
Por ultimo, damos
Salir.
| = | Administrar Agregados — »
Inicio Compartir Vista Herramientas de imagen A e(

: - : P
* U . ,Movera ~ 3¢ Eliminar ~ T FH seteccionar todo
W -

15 Mo seleccionar ninguno

Anclaral  Copiar Pegar Capiar a Cambiar nombre ~ Nueva Propiedades . )
acceso rapido [z ? ! carpeta - £ EF Invertir seleccion
Portapapeles Crganizar Muevo Abrir Seleccionar
&« v 4 » Esteequipe » Documentos » Agregados v O pel
~
() MNombre Tamafioc Tipe

> 3 Acceso rdpido
@ Agregado a convertir 1

@ Agregado a convertir 1
@ Agregado a convertir 2
@ Agregado a convertir 2
@ Agregado a convertir 3
@ Agregado a convertir 3
@ Agregado a convertir 4
@ Agregado a convertir 4
@ Agregado a convertir 5
@ Agregado a convertir 5

2920KB Documento Adob...
1,161 KB Archive TIF
2920 KB Documento Adob...
1,161 KB Archive TIF
2920KB Documento Adob...
1,161 KB Archive TIF
2920KB Documento Adob...
1,161 KB Archive TIF
2920KB Documento Adob...
1,161 KB Archive TIF

> 32 Dropbox
> o OneDrive - Personal

v [ Este equipo
> ‘ Descargas
> Documentos
» [ Escritorio
> [=] Imagenes
> J) Musica
> _J Objetos 3D
> m Videos
» i, Dizco local (C)
> [ Unidad de DVD RW
> == Archivos (\110.18.4.
> =g Utilerias (0100842 |, 5

10 elementos

Buscar en Agrega...

Selecciona un archivo para obtener la vista previa,
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